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Designing IP Subsystems

IMPORTANT: This tutorial requires the use of the Kintex®-7 family of devices. You will need to
update your Vivado tools installation if you do not have this device family installed. Refer to the
Vivado Design Suite User Guide: Release Notes, Installation, and Licensing (UG973) for more
information on Adding Design Tools or Devices.

Introduction

The Xilinx® Vivado® Design Suite IP integrator tool lets you create complex system designs by
instantiating and interconnecting IP cores from the Vivado IP catalog onto a design canvas. You can
create designs interactively through the IP integrator design canvas GUI, or programmatically using a
Tcl programming interface. You will typically construct designs at the AXI-interface level for greater
productivity; but you may also manipulate designs at the port level for more precise design control.

This tutorial walks you through the steps for building a basic IP subsystem design using the IP
integrator tool. You will instantiate a few IP in the IP integrator tool and then stitch them up to create
an IP sub-system design. While working through this tutorial, you will be introduced to the IP integrator
GUL run design rule checks (DRC) on your design, and then integrate the design into a top-level design
in the Vivado Design Suite. Finally, you will run synthesis and implementation and generate a bitstream
on the design.

VIDEO: You can also view the Designing with Vivado IP Integrator quick take video to learn more about
this feature of the Vivado Design Suite.

Tutorial Design Description

This tutorial is based on a simple non-processor based IP integrator design. It contains a few peripheral
IP cores and an AXI interconnect core, which connects to an external on-board processor.

The design targets an xc7k325 Kintex®-7 device. The tutorial uses a small design with minimal
hardware requirements and to enable timely completion of the tutorial, as well as to minimize the data
size.

TIP: Although the tutorial design targets an xc7k325 Kintex-7 device, you can choose another
part, such as the xc7a35 Artix®-7 device for use with the WebPack version of the Vivado Design
Suite. The tutorial results should be similar.
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Hardware and Software Requirements

Refer to the Vivado Design Suite User Guide: Release Notes, Installation, and Licensing (UG973) for a
complete list and description of the system and software requirements for the Vivado Design Suite.

Locating Tutorial Design Files

You can find the design file for this tutorial on the Xilinx website: Reference Design File.

Extract the file named top ipi.xdc to a directory. That directory is called the <Extract Dir> in
this tutorial.

Designing IP Subsystems Using IP Integrator www.xilinx.com Send Feedback 5
UG995 (v2017.3) October 13, 2017 [—\/—]


https://www.xilinx.com/
https://www.xilinx.com/cgi-bin/docs/rdoc?v=2017.3;t=vivado+release+notes
https://www.xilinx.com/cgi-bin/docs/ctdoc?cid=97929686-4d37-4bd1-89b5-76e47d7c321a;d=ug995-design-file.zip
https://www.xilinx.com/about/feedback.html?docType=Tutorials&docId=UG995&Title=Vivado%20Design%20Suite%20Tutorial%3A%20Designing%20IP%20Subsystems%20Using%20IP%20Integrator&releaseVersion=2017.3&docPage=5

& XILINX

ALL PROGRAMMABLE..

Lab 1: Designing IP Subsystems in IP Integrator

Step 1: Creating a Project

1. Open the Vivado IDE:
2. On Linux, change to the directory where the Vivado tutorial design file is stored:
cd <Extract Dir>/Vivado Tutorial
3. Then launch the Vivado Design Suite: vivado
On Windows, launch the Vivado Design Suite:
Start > All Programs > Xilinx Design Tools > Vivado 2017.x > Vivado 2017.x"
As an alternative, click the Vivado 2017.x Desktop icon to start the Vivado IDE.

The Vivado IDE Getting Started page contains links to open or create projects and to view
documentation, as shown in the following figure:

¢ Vivado 2017.1

File  Flow Tools Window Help Q- Quick Access

VIVADO!

HLx Editions

Quick Start

Create Projes

Learning Center

Documentation and Tutorials >
Quick Take Videos >

Figure 1: Vivado IDE Getting Started Page

! Your Vivado Design Suite installation may called something different from Xilinx Design Tools on the Start
menu.
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Lab 1: Designing IP Subsystems in IP Integrator

4. In the Quick Start page, select Create Project.

5. The New Project wizard opens. Click Next to confirm the project creation.

6. In the Project Name page, shown in the following figure, set the following options:
e Type the project name: project ipi

e Enter the project location: <project directory>

23 |

¢ New Project
Project Name

Enter a name for your project and specify a directory where the project
data files will be stored.

Project name:  project_ipi
Project location:  C:iTempiutorials/2017.3/JG995 IZ‘

+| Create project subdirectory

Project will be created at. C:iTempitutorialsf2017 .3/UG995/project_ipi
Fon

Figure 2: Create Project

7. Ensure that Create project subdirectory is checked, and click Next.

8. In the Project Type dialog box, select RTL Project, and click Next, as shown in the following figure:

¢ New Project @

Project Type
Specify the type of projectto create. ‘

e RTL Project
You will be able to add sources, create block designs in IP Integrator,
generate IP, run RTL analysis, synthesis, implementation, design planning
and analysis

D Do not specify sources at this time

Post-synthesis Project You will be able to add sources, view device
resources, run design analysis, planning and implementation

10 Planning Project
Do not specify design sources. You will be able to view partipackage
resources.

Imported Project
Create a Vivado project from a Synplify, XST or ISE Project File.

Example Project
Create a new Vivado project from a predefined template

=y

Figure 3: Specify Project Type
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9. In the Add Sources dialog box:
e Set the Target language to VHDL or Verilog
e Set the Simulator Language to Mixed
e Click Next.

You will add sources later using the design canvas in the Vivado IP integrator to create a subsystem
design.

10. In the Add Constraints dialog box, click Next.

11. In the Default Part dialog box, shown in the following figure, make the this entries:
e Select Parts
e Set Family: Kintex-7
e Set Speed grade: -2

¢ Mew Project 23

Default Part

Choose a default Xilinx part or board for your project. This can be changed later. ‘

Select | {8 Parts | B Boards

~ Filter

Product category: Al v Speed grade: -2 v

Eamily: Kintex-7 v Tempgrade:  AllRemaining

Package: All Remaining

Reset All Filters
Search: v
IIOPin  Available LUT . Block  Ultra Gb

i Count  10Bs Elements AILAGES RAMs  RAMs B Transceivers
{8} ¥C7k3I25HDVET -2 676 400 203800 407600 445 0 840 g -
{8} xcTK325tbva00-2 00 500 203800 407600 445 0 840 16
{8} xCTK325tFg676-2 G676 400 203800 407600 445 0 840 g
8} ¥CTk3251ge00-2 900 500 203800 407600 445 o 840 16
18} ¥C7K325HTVET6-2 676 400 203800 407600 445 v] 240 2
{8} ¥C7K3I25HTVA00-2 00 500 203800 407600 445 0 840 16
{8} xc7k355tFg901-2 901 300 222600 445200 715 0 1440 24
(ﬂ 7 kKARATAN1-2 an1 ann FRPAO0 445200 715 n 1440 24 5 =2

Figure 4: Select Default Part
12. Choose the xc7k325tffg900-2 part from the listed parts, and click Next.
13. Review the project summary in the New Project Summary dialog box.
14. Click Finish to create the project.

The new project opens in the Vivado IDE.
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Lab 1: Designing IP Subsystems in IP Integrator

Step 2: Creating an IP Integrator Design

In the Flow Navigator, select Create Block Design.

The Create Block Design dialog box opens, as shown in the following figure:

¢ Create Block Design x
Please specify name of block design. ‘
Design name: subsystem_1
Directaory: lz0 =Local to Project= hd
Specify source set Design Sources 4

Figure 5: Create Block Design Dialog Box

In the Create Block Design dialog box, set the following:
e Design Name: subsystem_1

e Set Directory: Local to Project

e Specify source set: Design Sources

e C(lick OK.

The Vivado IP integrator displays a design canvas to let you quickly create complex subsystem
designs by integrating IP cores.

Click the Add IP button in the block design canvas +

Alternatively, you can also right-click on the design canvas to open the context menu and select
Add IP.

TIP: To open the IP Details window beside the IP catalog, as shown in Figure 6, type ‘Ctrl-Q’ as
described at the bottom of the IP Catalog window. This window lets you see details of the
currently selected IP in the catalog.

In the search field of the IP catalog, type spi to find the AXI Quad SPL
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Search: spi

FF AXI Quad SPI

Lab 1: Designing IP Subsystems in IP Integrator

{1 match)
Mame:
Version:
Interfaces:

Description:

Status:
License:
Change Log:
Vendor:
VLNV
Repository:

EMTER to select, ESC to cancel, Cirl+0 for IP details

IP Details X

AXl Quad SPI

3.2 (Rev. 11)

A4

SPIInterface for SPI Based Slave

Production

Included

View Change Log

Xilinx, Inc.
xilink.comiip:axi_quad_spi:3.2

cXilimoVivado/2017 _1/datalip

Figure 6: Instantiate AXI Quad SPI IP

5. Select the AXI Quad SPI core and press enter on the keyboard, or simply double-click the core in
the IP catalog.

The AXI Quad SPI core is instantiated onto the IP integrator design

canvas.

6. Right-click the IP integrator canvas to open the popup menu, and

select Add IP.

7. In the Search field of the IP integrator catalog, type IIC.

8. Either double-click or press Enter on your keyboard to instantiate

the AXTIIC IP.

axi_quad _spi 0
|4 AXI_LITE
oF sPL0 +|||
ext spi_ck
, STARTUP_IO + |||
s_axi_aclk
. ip2intc_irpt
s _axi_aresetn
AXI Quad SP

9. Use the Add IP command to instantiate the flowing IP cores:

AXI Uartlite
AXI BRAM Controller
AXI Interrupt Controller

AXI Interconnect
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Lab 1: Designing IP Subsystems in IP Integrator

The IP integrator canvas should look similar to the following figure. The relative positions of the
blocks placed on the canvas might be slightly different.

Diagram

a 9

o -
o Wy -

o Q +

* Designer Assistance available. Run Connection Automation

am irarconnact_0

A Interrupt Camtmilier

A Imaroonne ot

200X

¥ C 9

AN BERAM Contrallar

axi_uarfite_0

ax e 0

A Cuad 5P

Figure 7:
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Step 3: Creating External Connections

At this point, you have instantiated several AXI slaves that you can access through an external master
such as an on-board processor. To connect to an external master controlling these slaves, you will
connect the SO0 AXT interface pin on the AXI Interconnect to an external port.

An interface is a grouping of signals that share a common function, containing both individual signals
and multiple buses. By grouping these signals and buses into an interface, the Vivado IP integrator can
identify common interfaces and automatically make multiple connections in a single step. See the
Vivado Design Suite User Guide: Designing IP Subsystems Using IP Integrator (UG994) for more
information on interface pins and ports.

1. Right-click the SO0_AXI interface pin on the AXI Interconnect to open the popup menu, and select
Create Interface Port.

ax_interconnect_0

L)
External Interface Properties...

% Highlight 4

¥ Delete
E cCopy

Q  Search...
Wr  Select Al

4+  Addip.
Add Module...

~y

Run Connection Automation...
IP Settings...
[¥  validate Design

Make Connection...

Disconnect Pin

Expand/Collapse 4

Create Hierarchy...
Create Comment

Create Interface Port... Cirl+L

Figure 8: Right-Click SO0_AXI Interface Pin
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Lab 1: Designing IP Subsystems in IP Integrator

The Create Interface Port dialog box opens, as shown in the following figure.

nterface Port

0
[}
D

Create interface port

Interface name: S00_AXI

Mode: SLAVE

v/ Connectto selected interface S00_AXI

Search:

{I xilinx.com:interface:aximm_rtl:1.0
(I xilinx.com:interface:axis_rtl:1.0
I xilinx.com:interface:bram_rtl:1.0
{I xilinx.com:interface:bscan_rtl:1.0
(I xilinx.com:interface:can_rtl:1.0
| {p xilinx.com:interface:cap_rtl:1.0
| I xilinx.com:interface:chi_rti:1.0
! I xilinx.com:interface:cpri_hdlc_rtl:1.0
l

Figure 9: Create Interface Port

2. Click OK to accept the default settings.

The Vivado IP integrator adds the external SO0 AXT interface port to the subsystem design, and
automatically connects it to the SO0 AXT interface pin on the AXI Interconnect core.

On the AXI Interconnect, connect the Clock and the Reset pins to external ports using the Create
Port command. Because these are not interface pins, you will not need an interface port to connect

them.
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Lab 1: Designing IP Subsystems in IP Integrator

3. Right-click the ACLK pin of the AXI Interconnect, and select Create Port, as shown in the following
figure:

ax_interconnect_0

.
S00_AXI |+ S0O_AXI
Block Pin Properties...

*. Highlignt »

Delete

Copy

[(z2zzzaaxn.
m X

Search

# 0

Select All

+  sddip.
Add Module

™ Make External

& Run Connection Automation
IP Settings

[ Validate Design

Start Connection Mode

Make Connection...

Disconnect Pin Inside Hierarchy

nterconnect 0
- ExpandiCollapse 3

Create Hierarchy...

.0 S00_AXI
GION [get_bd_intf_pins Create Comment
_bd_intf ports 300 _RXI Create Port... Ciri+K

Figure 10: Create Port

4. In the Create Port dialog box, shown in Figure 11, specify the Frequency as 200 MHz, leaving
everything else at its default value.

5. Click OK.
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-

¢ Create Port

&

Create port and connect it to selected ping and ports

y
Portname: ACLK
Direction: Input w
Type: Clock v
Create vector:

Frequency (MHz). 200

+' Connectto "ACLK selected pin

o)

Figure 11: Create Port - ACLK

6. Right-click the ARESETN pin of the AXI Interconnect and select Create Port.
The Create Port dialog box opens as seen in in the following figure.

7. Set the Polarity to Active Low.

8. Click OK to accept the default settings.

¢ Create Port =]
Create port and connect it to selected pins and ports ‘
Port name: ARESETM
Direction: Input ~
Type: Reset w
Create vector.
Polarity: Active High ® Active Low

< Connectto ‘ARESETN selected pin

o

Figure 12: Create Port - ARESETN

IMPORTANT: /P integrator treats an external reset coming into the block design as
asynchronous to the clocks. You should always synchronize the external resets with a clock
domain in the IP subsystem to help the design meet timing.
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Lab 1: Designing IP Subsystems in IP Integrator

You can use a Processor System Reset block (proc_sys reset) to synchronize the reset. The
Processing System Reset is a soft IP that handles numerous reset conditions at its input and
generates appropriate system reset signals at its output; however, if a clock and a reset are external
inputs to the block design, and the reset signal synchronizes externally to the clock, then you need
to associate the related clock with the reset. This does not require the Processor System Reset block.

Double click the ACLK port to open the Customize Port dialog box.

A clock is typically associated with a Bus Interface. In this case, we can associate this clock pin to the
S00_AXTI interface. In the Associated Busif field, type S00_AXIL

Set the Associated Reset field to ARESETN.
Click OK.
The dialog box looks like the following figure:

¢ Customize Port @

intf_clock_v1_0 (1.0) ¢

Component Mame  ACLK

Frequency (MHz) 200

Phase 0.000

Clk Domain subsystem_1_ACLK
Associated Busif S00_AXI

Associated Clken 0

Associated Reset ARESETM

Associated Async Reset | 0

OK | | Cancel

Figure 13: Customize Port — Associated Reset
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Now you can connect the AXI clock and reset nets to the remaining master and slave clocks and
resets of the AXI Interconnect.
13. Place the cursor on top of the SO0_ACLK pin of the AXI Interconnect.

Notice that the cursor changes into a pencil indicating that a connection can be made from that pin.
Clicking the mouse button here starts a connection on the SO0 ACLK pin.

14. Click and drag the cursor from the SO0 ACLK pin to the ACLK port, as shown in the following
figure.

TIP: You must press and hold down the mouse button while dragging the connection from the
S00 ACLK pin to the ACLK port.

As you drag the connection wire, a green checkmark appears on the ACLK port indicating that you
can make a valid connection between these points. The Vivado IP integrator highlights all possible
connection points in the subsystem design as you interactively wire the pins and ports.

15. Release the mouse button and Vivado IP integrator makes a connection between the S00 ACLK pin
and the ACLK port, as shown in the following figure:

am_irdarcannect_(

: .
S00_sx1 D-l_:II- o

MACLE BCLE

ARESETN — o NRESETH ,_
5 H—n H

SO0 ACIE = R
Moo e+ |5 i

500 ARESETH lil I = 1] s

D0 AUCLE .i. = Pt 1

MO0 ARESETH

wot e Connect from ‘S00_ACLK' port to "ACLK'" port’

M0 ARESETM

A e

Figure 14: Connect the S00_ACLK Pin to the ACLK Port

16. Repeating the steps outlined above, connect the M00 ACLK and the MO1 ACLK to the ACLK port.
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The connections to the AXI Interconnect should now appear as shown in the following figure:

axi_interconnect_0

S00_AXI ,
- D_|— + S00_AXI

ACLK [ D—pm ACLK
ARESETN [ »——— ARESETN
e S00_ACLK I?l MO0 AXI L5
— S00_ARESETN H“—H =
= X MO1T_AXI i
= MOO_ACLK [ Ead | :
— M0OO_ARESETN
- MO1_ACLK

= MO1_ARESETN

AX| Interconnect

Figure 15: ACLK Connections

Similarly, connect the reset pins of all the masters and slaves to the ARESETN port.

17. Place the cursor on the SOO_ARESETN pin, then click and drag the cursor to the ARESETN port, as
shown below.

18. Release the mouse button to make the connection.

—tf_axl_aresetn TR PO u-,,-j] —EJI

AXL BRAM Controller

axi_interconnect_0
[ T
S00_AXT [y=——rii|<500_AXI
ACLK [ =ACLK
ARESETN ARESETN

'!c?'f’?—"f‘ Connect from 'SO0_ARESETN' port

voo_adt0 ARESETN_1' net
= MOO_ARESETN

MO1_ACLK

= MO1_ARESETN

L |

AXI Interconnect

Figure 16: Connect SO0_ARESETN to the ARESETN port
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19. Repeat the steps to connect the MOO_ARESETN and the MO1_ARESETN pins of the AXI
Interconnect to the ARESETN port, as shown in the following figure:

axi_interconnect_0

500_AXI D—I
£+ s00_Ax

ACLK [ ACLK
ARESETN [ ARESETN
500_ACLK .?.

Moo AXI 4 i
S00_ARESETN H<—H = i
3 MOT_AXI 4 f
MOO_ACLK lm i
M0O ARESETN
MO1_ACLK
MO1_ARESETN

AXI Interconnect

Figure 17: ARESETN Connections

Step 4: Customizing IP

1. Double-click the AXI Interconnect core to open the Re-Customize IP dialog box as seen in the
following figure:

¢ Re-customize IP =3 ]
AXI Interconnect (2.1) ‘
© Documentation IP Location

Component Mame | axi_interconnect_0

Top Level Settings Slave Interfaces Master Interfaces
Number of Slave Interfaces 1 -
Mumber of Master Interfaces 5 w
Interconnect Optimization Strategy Custom “

AX] Interconnect includes IP Integrator automatic converter insertion and configuration.
When the endpoint IPs attached to the interfaces of the AXI Interconnect differ
in width, clock or protocol, a converter IP will automatically be added inside the interconnect
If a converter IP is inserted, IP integrator's parameter propagation automatically
configures the converter to match the design
To see which conversion IPs have been inserted, use the IP integrator
‘expand hierarchy’ buttons to explore inside the AXI Interconnect hierarhcy.

NOTE:Addressing information for A1 Interconnect is specified in the IP Integrator address editor.

Enable Advanced Configuration Options

| OK | | Cancel

Figure 18: Re-customize the AXI Interconnect
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2. From the Top Level Settings Tab, set the Number of Master Interfaces to 5 from the pull down
menu.
3. Leave all the remaining options set to their default values, and click OK.

The Vivado IP integrator re-customizes the AXI Interconnect, changing the number of master
interfaces to five, and adding the necessary clock and reset pins to support these new master
interfaces, as shown in the following figure:

axi_interconnect_0

4 s00_axi
ACLK
S00_AX| ARESETN

S00_ACLK

ACLK [ S00_ARESETN
RESETN [ = MOO_ACLK MOD_AXI
MOO_ARESETN MO1_AXI
MO1_ACLK MOZ_AXI
MO1_ARESETN MO3_AXI
MO2_ACLK MO4_AX|
M02_ARESETN
MO3_ACLK
MO3_ARESETN
MO4_ACLK
M4 _ARESETN

EEN
XX
EEE

+++++

AXI Interconnect

Figure 19: AXI Interconnect with 5 Master Interfaces

4. Connect all the new clocks to the ACLK port, and the new resets to the ARESETN port.
Now you can connect the five slave IP cores to the AXI Interconnect.

5. Connect the S_AXI interface of the AXI BRAM Controller to M00_AXI interface of the AXI
Interconnect.

6. Connect the s_axi_aclk and the s_axi_aresetn pins of the AXI BRAM Controller to the ACLK and
ARESETN ports. Figure 20 shows these connections.
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axi_interconnect_0
.
| 4 500_AXI
| ACLK
S00_AX ' = ARESETN
- S00_ACLK
ACLK [—man - S00_ARESETM
ARESETN [ 9] = moo_AcK MOD_AX] o |l
& = MO0 ARESETN .Y. MO1_AXI 4 [
- MO1_ACLK H—N Moz ax +f
. - MO1_ARESETN .ﬁ. MO3_AXI 4
- MO2_ACLK MO4_AXI o fi
b - M0Z_ARESETN
- M03_ACLK
b - M03_ARESETN
. MO4_ACLK
» - MO4_ARESETM
AXI Interconnect
axi_bram_ctrl_0
+ 8 BRAM_PORTA +|||

: BRAM_PORTE |||
5 _axi_amesetn

AXl BRAM Controller

Figure 20: Connect the AXI BRAM Controller to the AXI Interconnect

7. Using the same steps, connect the remaining slave IP cores in the design to the AXI Interconnect.

O TIP: The order of connections between the S_AXI interface pins on the IP slaves and the M_AX|
interface pins on the AXI Interconnect does not matter.

8. Click the Regenerate Layout button on the sidebar menu.

The IP integrator design canvas should look similar to what shows in Figure 21.
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axi_bram_ctd_0
Zl 4 5_AxI
i t g} BRAM _PORTA + ||
- - BRAM_PORTE + ||
a_gn_aregein
- a_inerconnect_0 A BRAM Contraller
500 AxI [ £+ s00_Axi ai_iic_0
ACLE [ ACLK .
5 Ax| e
ARESETN [ ARESETN - ': o o . __: I
800_ACLK e = ool b
b 500_ARESETN AL wolt0]
MOD_ACLK MOO_AXI o | AXIC
b= oo AReseTd BB goa s 4 i .
- x A axi_intc_0
MO_ACLK H—N M2 _Axl 4 (i
—— MOTARESETN petom MO3_axl 4| A 5
MO2 ACLK WA o | a_and_aclk
z _ i _am ki
—= MOZ ARESETM a_an_afesein + ”
MO3 ACLK - 0]
b= W03 ARESETN
- AX| Interrupt Controller
M0d_ACLK
L= W10 ARESETH axi_quad_spi_0
AX] Interconnect [ AXLLITE SP_0 +|||
= exi gpl ol
= STARTUP_IO 4|
a_an sk ks it
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AX| Quad SPI
axi_uartlite_0
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- mesrupt
5_8_aresein
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Figure 21: Connecting to the AXI Interconnect

At this point, you should save the IP integrator subsystem design.

9. Click the File > Save Block Design command from the main menu.
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Step 5: Running Connection Automation

At this point, there are still some output interface pins that you must connect external to the subsystem
design, such as the following:

e UART interface of the AXI Uartlite
e SPI 0 interface of the AXI Quad SPI
e IIC interface of the AXIIIC.
Also, note that the AXI BRAM Controller is not connected to a Block Memory Generator.

IP integrator offers the Designer Assistance feature to automate certain kinds of connections. For the
current subsystem design, you can connect the UART, SPI and IIC interfaces to external ports using
connection automation. You can also use the Designer Assistance feature to connect a Block Memory
Generator to the BRAM Controller.

1. Click the Run Connection Automation link, in the banner at the top of the design canvas.
Diagram Address Editor
Q@ a 11 X © Q s +

M Designer Assistance available. Run Connection Automation

Figure 22: Run Connection Automation for /axi_quad_spi_0/SPI_0

The Run Connection Automation dialog box opens.

2. Select All Automation (0 out of 5 selected) as shown in the following figure. This selects all
external interfaces and the BRAM Controller for auto connection.

¢ Run Connection Automation &3

Automatically make connections in your design by checking the boxes ofthe interfaces to connect. Select an interface on the leftto
display its configuration options on the right.

Q = =
~ & All Automation (5 out of 5 selected)
~ |/ F axi_bram_ctrl_0
| {I} BRAM_PORTA
v/ {I} BRAM_PORTB
~ /I3 axi_ic_0 Select an interface pin on the left panel to view its options
Yk Ic
~ /| 4F axi_quad_spi_0
<k SPI_0
v || FF axi_uartlite_0
< It UART

Figure 23: Run Connection Automation Dialog Box
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3. Select and highlight the interfaces, as shown in the following figure, to see a description of the
automation that the tool offers as well as any options needed to connect these interfaces.

-

¢ Run Connection Automation

display its configuration options on the right.

~ | All Automation (5 out of 5 selected)
~ || %F axi_bram_ctr_0
v {I} BRAM_PORTA
v {I} BRAM_PORTB
~ | axi_iic_0
Vi nc
~ || 4F axi_quad_spi_0
+ {Ik SPI_D
~ || 4F axi_uartlite_0
I} UART

Automatically make connections in your design by checking the boxes of the interfaces to connect. Select aninterface on the left to

(=]

Description

Connect BRAM controller to Block Memory Generator.

Options

Blk_Mem_Gen: | Auto

Figure 24: The Run Connection Automation Dialog Box Options

4. Click OK.

5. All the external interfaces connect to

I/O ports, and the BRAM Controller connects to the Block

Memory Generator, as shown in the following figure:

Diagram ?2 _0aX
LY -
@ g 2 & O Q s + B C 9 & o
* Designer Assistance available. Run Connection Automation
axi_bram_cwl_0
’ \ axi_bram ci_0_bram
i+ s a0 [ )
+ 8 BRAM_PORTA + ||| e |+ BRAM_PORTA rets bumy
8. adk BRAM_PORTE 4 ||| s |4 BRAM_PORTE rs®)_busy
4§ 5_an_awmen - | - - J
axi_inerconnect 0 - 4 [£ & Meam
S00_AXI 4 s00 0 axi_intc_0
ACLK [O» ACLK (
ARESETN [ ARESETN st A
H—— s acix :*:*""' p——y
| SO0 ARESETN :J A m—
Ll Mo0_acix MOD_AX 4 [ | ea
—=f MU_ARESETN  MOT_AX 4 [t X1 Ind
H—=|Mo1ACK i MQ2 AN 4 e asd, cqound 81,0
f—=f MOI_ARESETN  MOJ_AXI 4 [Fime e ‘
H—ef MI2_ACLK MO A+ |+ wa_uTe b
| M22_ARESETN ot api_ck snmi‘_rg : i D w0
b M13_ACLK & adk =
¢ MO3_ARESETN @ = e -t
L Moe_aaix .
L moe_ameseTn
L aa_jic_0
+ S.Aa L +‘:' O x o
i w2t _iegh
5 _awi_esetn a0
axi_uarite_0
4+ 5 00 i
& i uaRT +|| O van i 0
— rmernapt
&_wi_avessetn

Figure 25: Port Connections after Running Connection Automation
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6. Right-click the newly added spi_rt1l port to open the pop-up menu, and select the External
Interface Properties command.

In the External Interface Properties window, you can change the Name of the port if needed. The
Vivado IP integrator feature automatically assigns the name of the port when connection
automation is run. For now, leave the spi rtl 0 port named as it is.

7. Right-click the ext_spi_clk pin of the AXI Quad SP], and select Create Port.

The Create Port dialog box opens as shown in the following figure:

¢ Create Port @

Create port and connect it to selected pins and ports

Port name: | ext_spi_clld |
Direction: Input w
Type: Clock L

Create vector:

Frequency (MHz): 100

v Connectio’ext_spi_clk' selected pin

Figure 26: Create ext_spi_clk Port

8. Set the Frequency to 100 MHz, if it is not already set, and click OK.
9. Click the Regenerate Layout button C to redraw the subsystem design.

The optimized layout of the design should now look similar to Figure 27:
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Figure 27: Completed IP Subsystem Design

Step 6: Managing Signals with CONCAT and CONSTANT
Blocks

Now you will connect the interrupt signals on the various IP slaves to an interrupt controller through a
Xilinx Concat block, to concatenate the individual interrupt signals into a bus. The Concat block is a
general-purpose block to combine multiple inputs into a single bus output. The individual interrupt
signals from different AXI slave cores need to be combined into a bus because the Interrupt Controller
takes a bus at its input.

1. Right-click the design canvas to open the popup menu and select Add IP.

2. In the search field, type concat to find the Xilinx Concat block, and double-click the core.
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The Xilinx Concat core is instantiated onto the IP integrator design canvas, as shown in the following
figure:

xlconcat_0

In0[0:0]

dout[1:0]
In1[0:0]

Concat

Figure 28: Xilinx Concat Block

3. Right-click the Concat block to open the popup menu, and select Customize Block.

The Re-customize IP dialog box opens as shown in the following figure:

¢ Re-customize IP @

coneat (2.1) P
@ Documentation IP Location

Show disabled ports Component Name | xiconcat_0

Number of Ports
(@) Adto ) In0 widin

o ) In1 Width

a ) In2 Width

= | = = =] [~

(@) Auta ) In3 widtn

In0[:0]

In[o:0]
dout[:0]
In2(0:0]

In3[0:0]

NOTE: The In0 portis connecled to the LSB bits of the output, and
the In[Number of Ports - 1] input port is connected to the MSB bits of the output.

Figure 29: Customize Concat Block

4. Change the Number of Ports to 4, and click the mouse in the In0 Width field to accept the
change.

The dialog box is updated to reflect the new number of input ports. Three ports are needed to
connect the interrupt pins on the various slave IP blocks into the Interrupt Controller. You will use
the fourth port to demonstrate tying a signal high or low with the Constant block.

5. Click OK.

Now connect the interrupt signals of the AXI slaves to the Concat block to create an interrupt bus.

O TIP: To pull signals out of a bus, use the Slice block instead of the Concat block.
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6. Place the cursor on top of the interrupt pin of the AXI UART-Lite.
Notice that the cursor changes into a pencil indicating that a connection can be made from that pin.

7. Click and drag the cursor from the interrupt pin to an input pin on the Concat block, as shown in
Figure 30.

As you drag the connection wire, a green checkmark appears on the Input port indicating that a
valid connection can be made between these points.

8. Release the mouse button and Vivado IP integrator makes a connection between the pins.

9. Connect the interrupt pins on the AXIIIC block and the AXI Quad SPI block to input pins on the
Concat block, using the same process.
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Figure 30: Connect the Interrupt Signals to Concat Block

At this point, you have connected the interrupt signals to the Concat block, and there is a remaining
unconnected input pin. You could re-customize the block to include only the required number of
inputs. For this tutorial though, you will use the Constant block to tie the extra input down instead.

10. On the design canvas, right-click and select Add IP.
The IP catalog opens.
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11. In the search field, type cons to find the Xilinx Constant block, and double-click the core in the IP
catalog.

The Xilinx Constant block is instantiated into the subsystem design.
12. Relocate the block as needed to be close to the Concat block.

13. Click and drag the cursor from the output pin on the Constant block, and connect it to the dangling
fourth input pin on the Concat block.

As you drag the connection wire, a green checkmark appears on the input pin indicating that a valid
connection can be made between these points.

14. Release the mouse button and Vivado IP integrator makes a connection between the pins.

Double-clicking any of the interrupt pins on the various AXI slaves shows that by default they are
active high, or triggered on the rising edge. In this case, you must use the Constant block to tie
down the fourth input on the Concat block to prevent needless interrupt.

15. Double-click the Constant block to re-customize the IP.
The Re-customize IP dialog box opens, as shown in the following figure.

16. Set the Const Val field to 0, as shown below, and click OK.

¢ Re-customize IP X

Constant (1.1) ¢

€ Documentation IP Location

Show disabled ports Compeonent Name | xlconstant_0

ConstWidth | 1 [1-4096]

dout[0:0
ConstVal 0

oK ‘ ‘ Cancel

Figure 31: Set Constant Value

The fourth input of the Concat block is no longer floating. Now you can connect the concatenated
interrupt signals from the Concat block to the Interrupt Controller.

17. Click and drag the cursor from the output pin on the Concat block, dout [3:01], and connect it to
the intr[0:0] pin of the Interrupt Controller block.

18. Click the Regenerate Layout button to redraw the subsystem design. C
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The optimized layout of the design should now look similar to the following figure:

Lab 1: Designing IP Subsystems in IP Integrator
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Figure 32: Connect Concat Block to Interrupt Controller

Notice that the 1-bit bus width of the interrupt signal on the Interrupt Controller block does not

match the 4-bit signal width from the Concat block. The Vivado tools correct this automatically
during design validation.

TIP: When you instantiate an Interrupt Controller block, the interrupt port by default is 1-bit.
During design validation, parameter propagation passes the width of the output signal from the

Concat block to the input signal of the Interrupt Controller, and the port width on the interrupt
controller changes automatically.

Q

19. Right-click the interrupt pin of the Interrupt Controller, to open the popup menu, and select Make
External.

This connects the interrupt output pin to an output port that is outside the IP subsystem design, to
a processor for example.

All the interrupts on the Interrupt Controller have a priority that is determined based on the order of
connection to the Concat block. Bit-0 of the interrupt bus has the highest priority.
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When the interrupt port goes high, or active, the processor determines which slave is causing the
interrupt. Multiple interrupts are handled according to their priority.

20. Click the File > Save Block Design command from the main menu.

Step 7: Using the Address Editor

For various memory mapped master and slave interfaces, IP integrator follows the industry standard IP-
XACT data format for capturing memory requirements and capabilities of endpoint masters and slaves.
This section provides an overview of how IP integrator models address information on a memory-
mapped slave.

Master interfaces have address spaces, or address_space objects. Slave interfaces have an
address_space container, called a memory map, to map the slave to the address space of the
associated master. Typically, these memory maps are named after the slave interface pins, for example
S_AXI, though that is not required.

The memory map for each slave interface pin contains address segments, or address segment
objects. These address segments correspond to the address decode window for that slave. A typical
AXH4-Lite slave will have only one address segment, representing a range of addresses. However, some
slaves, like a bridge, will have multiple address segments; or a range of addresses for each address
decode window.

When you map a slave to the master address space, a master address segment object is created,
mapping the address segments of the slave to the master. The Vivado IP integrator can automatically
assign addresses for all slaves in the design. However, you can also manually assign the addresses using
the Address Editor. In the Address Editor, you see the address segments of the slaves, and can map
them to address spaces in the masters.

TIP: The Address Editor tab only appears if the subsystem design contains an IP block that functions as
a bus master. In the tutorial design, the external processor connecting through the AXI Interconnect is
the bus master.

1. Click the Address Editor tab to show the memory map of all the slaves in the design.

Note: If the Address Editor tab is not visible then open it with the Window > Address Editor
command from the main menu.
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Address Editor
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Cell Slave Interface  Base Mame  Offset Address  Range

? - 0e X

=

High Address

Figure 33: Address Editor

2. Right-click anywhere in the Address Editor and select Auto Assign Address.

This command maps slave address segments to master address spaces, thereby creating address

segments in the master. You can change these automatic addresses later by clicking in the

corresponding column and changing the values.

Alternatively, you can also click on the Auto Assign Address button ﬁ, on the block design canvas

toolbar to automatically assign the addresses.
3. The Auto Assign Address dialog box pops-up. Click OK.

The Address Editor should now look similar to the following figure:

Address Editor
Q = 2
Cell Slave Interface  Base Wame  Offset Address Range

v External Masters
~ [ S00_AXI (32 address bits : 0x00000000 [ 4G ])

= ayi_bram_ctrl_0 S_AXI Memo 0xC000_0000 K -
= gyi_jic_0 5_AX Reqg 6. ~
= ayi_intc_0 s_axi Reg 0x4120_0000 . =
== gyi_quad_spi_0 AXI_LITE Reqg 0x44R0 0000 6. =
= ayi_uarlite_0 S_AXI Reg 0x4060_0000 6. =

? 0 & X

£

High Address

0xCO00_1FFF
0x4080_FFFF
0x4120_FFFF
Ox44R0_FFFF
0x4060_FFFF

Figure 34: Automatically Assigned Addresses

4. Change the size of the address segments for the AXI BRAM Controller core by clicking in the

Range column and selecting 64K from the pull-down menu, shown in the following figure:
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Figure 35: Change Range Field of the AXI BRAM Controller

5. Select the Diagram tab, to return to the IP integrator design canvas.

Lab 1: Designing IP Subsystems in IP Integrator

Step 8: Validating the Design

1. From the sidebar menu of the design canvas, run the IP subsystem design rule checks (DRCs) by
clicking the Validate Design button .

The Validate Design dialog box opens, and validation should be successful.

2. Click OK.

3. Examine the interrupt bus width on the Interrupt Controller block.

Notice, as shown in the following figure, that the width now matches the width of the bus signal
coming from the Concat block. Parameter propagation has allowed the bus width to propagate
through the subsystem design as needed.
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Figure 36: Parameter Propagation Matches Bus Width

At this point, you should save the IP integrator subsystem design again.

4. Use the File > Save Block Design command from the main menu to save the design.
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Step 9: Creating and Implementing the Top-Level Design

With the IP subsystem design completed and validated, you need to prepare it for inclusion into the
top-level HDL design. The subsystem can be included as a module or block in the top-level design, or
may be the only block in the top-level design. In either case, you need to generate the HDL files for the

subsystem design.

1. Inthe Sources window, right-click the top-level subsystem design, subsystem_1, and select
Generate Output Products.

This command generates the source files for the IP cores used in the subsystem design, and any
related constraints file.

Q

w

¥

Sources Design Signa

| &+
Design Sources (1

» ] subsystem_1 (subst
Constraints
Simulation Sources (1

2o

Source Mode Properties...

Open File

Create HDL Wrapper...

View Instantiation Template

Generate QOutput Products...

Reset Qutput Products...

Diagram

@ aQ

—

Figure 37: Generate Output Products

The Generate Output Product dialog box opens, as shown Figure 38, to regenerate the various
output products associated with the subsystem design.

The Vivado IP integrator lets you choose how to handle the synthesis of the block design. The three
Synthesis Options include:

o Global: Synthesizes the block design as part of the top-level project, rather than as an out-

of-context blo

ck.

o Out-of-Context per IP: Synthesizes each IP in the block design separately, out-of-context of
the block design or the top-level design. This prevents each IP from being synthesized
unnecessarily, but requires updating and re-synthesizing each IP when it is updated.

o Out-of-context per Block Design: Synthesizes the entire block design at one time, but out-
of-context from the global or top-level design. This prevents the block design from being
synthesized unnecessarily when the top-level design is synthesized, but requires updating
and re-synthesizing the block design when any of the IP in it are updated.
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Figure 38: Generate Output Products dialog box

2. Leave the default selection of Out of context per IP.

3. Click Generate to generate all output products.

Alternatively, you can click Generate Block Design in the Flow Navigator, under the IP integrator

drop-down menu.

The Generate Output Products dialog box opens to confirm the output products are generated.

4. Click OK.
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5. The Out-of-context (OOC) runs for each IP in the design launch, shown in the Design Runs tab
below. OOC runs can take a few minutes to finish.

Design Runs
Q= €
Name
v synth_1 (active
impl_1
v Out-of-Context Module Runs
v C subsystem_1
C subsystem_1_axi_q...
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subsystem_1_xlcon...
subsystem_1_xlcon...
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+
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subsyste...
subsyste...
subsyste...
subsyste...
subsyste...
subsyste...
subsyste...
subsyste...
subsyste...

subsyste...

? -0 a X
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synth_design Complete!
synth_design Complete!
synth_design Complete!
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Running synth_design...
Running synth_design...
Queued...

Queued...

Queued... v

Figure 39: Out of context runs

6. After the Out-of-context runs are finished, in the Sources window, right-click the top-level subsystem
design, subsystem_1, and select Create HDL Wrapper.

> Constraints

Sources »  Design Signals
Q = & +
hd Design Sources (1)

> 4y subsystem_1 (subsystem_1.bd) (€

b Simulation Sources (1)

?_0O0
L

Diagram »  Addres
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[@ OpenFile Alt+0
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Figure 40: Create Top-Level HDL Wrapper
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The Create HDL Wrapper dialog box opens, and offers two choices:

10.

11.

e Copy generated wrapper to allow user edits: Choose this option if you will modify the
wrapper file. Often times a block design is a subset of an overall project.

In cases like these, you might need to edit the wrapper file and instantiate other design components
in the wrapper. If the I/O interface of the block design changes in any manner, you must manually
update the wrapper file to reflect those changes. The wrapper file created using this method is
written to the <project name>.srcs/sources 1/imports/hdl directory.

¢ Let Vivado manage wrapper and auto-update: Choose this option if you want the Vivado IDE
to generate and update the wrapper file as needed. The wrapper file created using this method
is automatically updated every time output products for the block design are generated, to
reflect the latest changes. The wrapper file is written to the
<project name>.srcs/sources 1/bd/<bd name>/hdl directory.

Choose the default option, let the Vivado manage wrapper and auto-update, as shown in the
following figure:

¢ Create HDL Wrapper -ﬁ.

You can either add or copy the HDL wrapper file to the project
Use copy option if you would like to modify this file

Options

O Copy generated wrapper to allow user edits

* LetVivado manage wrapper and auto-update

Figure 41: Create HDL Wrapper dialog box

Click OK.

The Vivado IDE creates a top-level HDL wrapper for the subsystem 1 block design and adds it to
the design sources.

With the top-level HDL source added to the project, you must now add design constraints to the
project prior to implementation.

From the Flow Navigator, click Add Sources.
Select the Add or Create Constraints option and click Next.

The Add Sources dialog box opens as seen in Figure 42.

In the Add or Create Constraints dialog box, click the # icon select Add Files or click the Add Files
button to add files.
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¢ Add Sources | 52 |

Add or Create Constraints

Specify or create constraint files for physical and timing constraint
to add to your project.

Specify constraint set. | & constrs_1 (active hd

+,

Constraint File  Location

top_ipixdc CATempi\project_IPhextract_directory
Add Files || Create File

Copy constraints files into project

':_'_?":' Finish | ‘ Cancel

Figure 42: Add Constraints File

The Add Constraints Files dialog box opens.
12. Select the top ipi.xdc filein <Extract Dir>, and click OK.

13. In the Add or Create Constraints dialog box, make sure that Copy constraints files into project is
checked.

14. Click Finish to add the constraints to the project.
You are now ready to synthesize, implement, and generate the bitstream for the top-level design.
15. In the Flow Navigator, click Generate Bitstream.

With a single click, this will complete all of the steps needed to synthesize, implement, and generate
the bitstream for the design.

The No Implementation Results Available dialog box opens as seen in the following figure:

Mo Implementation Results Available @

There are no implementation results available. OK to launch synthesis and
implementation? "Generate Bitstream’ will automatically start when synthesis
and implementation completes.

D Dont show this dialog again

Yes Mo

Figure 43: No Implementation Results Available
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16. Click Yes.

17. The Launch Runs dialog box pops up where you can specify various options for launching the runs.
Click OK.

18. After the Vivado Design Suite generates the bitstream, the Bitstream Generation Completed dialog
box opens, as shown in the following figure:

-

Bitstream Generation Completed

=

0 Open Implemented Design

() View Reports
(") Open Hardware Manager

(") Generate Memory Configuration File

[] Don't show this dialog again

0K l ’ Cancel

Figure 44: Bitstream Generation Completed

19. Click OK.

20. Verify that the design meets timing by looking at the Timing window as seen in the following figure:

Timing ? -0a X
Q = = Design Timing Summary
General Information -~
Timer Setings Setup Hald Pulse Width
Design Timing Summary Worst Negative Slack (WNS). 0786 ns Worst Hold Slack (WHS): 0.041ns Worst Pulse Width Slack (WPWS). 1732 ns
Clock Summary (2) Total Negative Slack (TNS):  0.000 ns Total Hold Slack (THS): 0.000 ns Total Pulse Width Negative Slack (TPWS): 0.000 ns
> "o Check Timing (157) Number of Failing Endpoints: 0 Number of Failing Endpoints: 0 Number of Failing Endpoints: 0
> w
Intra-Clock Pats Total Number of Endpoints: 7362 Total Number of Endpoints; 7347 Total Number of Endpoints: 2660

» = Inter-Clock Paths
» Other Path Groups

o JlarrloesrssDede

All user specified timing constraints are met.

Timing Summary - impl_1 (saved)

Figure 45: Timing Summary Report

O TIP: The Timing Summary also reports warnings related to the lack of input and output delays for

the primary input and output ports of the design. You can add these delays as design constraints
using the set_input_delay and set_ouptut_delay commands. See this link in the Vivado Design
Suite User Guide: Using Constraints (UG903) for more information on setting input and output
delays.
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Conclusion

This tutorial walked you through creating a simple IP integrator subsystem design by instantiating
common peripherals and local memory cores, and connecting them through an AXI Interconnect. You
then took the completed subsystem design into a top-level HDL design for implementation in the
Vivado Design Suite. This tutorial gave you hands-on experience and a basic understanding of many of
the features of the Vivado IP integrator tool.
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SAFETY CONCEPT OR REDUNDANCY FEATURE CONSISTENT WITH THE ISO 26262 AUTOMOTIVE SAFETY STANDARD (“SAFETY
DESIGN”). CUSTOMER SHALL, PRIOR TO USING OR DISTRIBUTING ANY SYSTEMS THAT INCORPORATE PRODUCTS,
THOROUGHLY TEST SUCH SYSTEMS FOR SAFETY PURPOSES. USE OF PRODUCTS IN A SAFETY APPLICATION WITHOUT A
SAFETY DESIGN IS FULLY AT THE RISK OF CUSTOMER, SUBJECT ONLY TO APPLICABLE LAWS AND REGULATIONS GOVERNING
LIMITATIONS ON PRODUCT LIABILITY.
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